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TIME TABLE 

 

Day 1 Time Lecture  

11-Nov 9.30-9.45 0-Welcome to the course Ian & Nadia* 

 
9.50-10.35 1-General introduction to light microscopy Ian/Ilan 

 
10.35-10.55 Break 

 

 
11.00-11.45 2-Principles of microscopy and microscope anatomy Ian  

 
11.50-12.30 Questions / Discussion session Ian Dobbie et al 

 
12.30-1.30 Lunch 

 

 1.35-2.20 3-Cameras for Imaging Louis Keal 

 2.25-5:00 Olympus Microscopes (viewing / demo) Olympus 

 

    

 

Day 2 9.30-10.30 4-Contrast enhancement (phase contrast and DIC) Ian Dobbie 

12-Nov 10.35-11.20 5-Basics of  fluorescence microscopy Carina/Ian 

 
11.20-11.45 Break 

 

 11.45-12.30 6-Fluorescent dyes and proteins Mark Howarth 

 
12.30-1.30 Lunch  

 

 1.35-2.30 7-Basic image processing / Image & data management David Pinto 

 2.35-5.00 Olympus Microscopes (viewing / demo)  Olympus 

 

    

Day 3 
9.30-10.15 8-Increasing contrast and resolution using optical 

sectioning Alan Wainman 

13-Nov 10.20-11.05 9-Live cell imaging Nadia Halidi 

 
11.05-11.25 Break 

 

 
11.30-12.30 10-Imaging at the molecular level: F-techniques Chris L. 

 
12.30-1.30 Lunch 

 

 1.35-2.15 11-Advanced image analysis (part 1) David Pinto 

 2:20-3:00 12-Advanced image analysis (part 2) David Pinto 

 

    

Day 4 9.30-10.15 13-Imaging Biology in context in organs & Tissues Matthew Stower 

14-Nov 10.20-11.05 14-Super resolution and SIM Lothar  

 
11.05-11.30 Break 

 

 
11.30-12.30 15-Nanometer resolution by localisation microscopy Jarno Makela 

 
12.30-1.30 Lunch 

 

 1.30-2.15 16-STED Chris L./Silvia G. 

 2.15-3.00 17-Bespoke microscope design Ian Dobbie 

 3.00-3.45 Conclusion   

 4:00-6:30 Beer & Pizza  

 

 

 
 

   

 
* Ian = Ian Dobbie; Nadia = Nadia Haladi; Carina = Carina Monico; Chris L = 
Christoffer Lagerholm; Lothar = Lothar Schermelleh; Silvia G. = Silvia Galiani 
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TIME TABLE 
      Advanced Microscopy Course Optional Friday 15th Nov 2019 

 
** signup sheets will be available during the course ** 

 

  Day 5 Optional Micron Demos  

    

Day 5 9.45-10.00 Morning group Assemble in Main Seminar Room 
 

15-Nov 10.00-12.00 Demonstrations of equipment (Morning rotations) Micron Team 

 12.00-13.45 Break  

 
13.45-14.00 Afternoon group Assemble in Main Seminar Room 

 

 
14.00-16.00 Demonstrations of equipment (Afternoon rotations) Micron Team 

 

 

Micron Team: Ian Dobbie, Nadia Halidi, Carina Monico, Ulrike Schulze, Alan Wainman. Other 
contributors, Richard Parton,  Matthew Stower, Lothar Schermelleh 

 
OR 

 
** Limited places, signup sheets will be available during the course ** 

 

  Day 5 Optional EM Day  

Day 5 9.30 – 10.30 Lecture: Biological EM in a nutshell Errin Johnson 

15-Nov 10.30-11.00 Discussion/Tea & coffee break  

 11.00-13.00 EM demonstration sessions (part 1) 

Group 1: Cryo-EM 

Group 2: Cell & Tissue EM  

EM Team 

 

 

 13.00-14.00 Lunch (not provided)  

 14.00 – 16.00 EM demonstration sessions (part 2) 

Group 2: Cryo-EM 

Group 1: Cell & Tissue EM  

EM Team 

 

 

 
EM Team: Adam Costin (COSMIC), Raman Dhaliwal (Dunn School EM Facility), Charlotte Melia 

(Bharat lab, Dunn School) and Errin Johnson (COSMIC/Dunn School EM Facility) 
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Vision 
 
The overall goal of the Advanced Microscopy Course is for the attendees to learn 
about the theoretical and practical aspects of bright field and fluorescence microscopy 
and their varied implementations, as well as gain an appreciation of instrumentation 
adjustment and design. 
 
Micron staff are available at any time to discuss any aspect of microscopy and your 
imaging requirements. We encourage discussion during the course and can be 
contacted at any time afterwards (see Useful contacts and information at the end of 
the handbook). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

_____________________________________________ 

 
Previous years’ lectures can be found here: 

_____________________________________________ 
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Detailed Course Schedule: 11th-15th November 
 

Please assemble for lecture five minutes before the start 

_____________________________________________ 

 

Day 1: Principles of Light Microscopy (Monday 11th) 
 
0 Welcome to the course / announcements 

 
1     Ilan Davis / Ian Dobbie General introduction to light microscopy 
     

• Outline the goals of the microscopy course  
• What is microscopy? 
• What is important for good microscopy? The fundamental principles / PSF 

• How to approach which technique to use 
 
 
 
2     Ian Dobbie    Principles of microscopy and microscope anatomy 
 

• Basic understanding of refraction and diffraction, and properties of lenses 
• Understanding of two different sets of conjugate planes, especially importance of 

objective back-focal plane 
• Understanding of factors affecting image resolution 

 
 
 
 
3   Louis Keal (Teledyne) Cameras for Imaging 
 

• Different camera technologies and how they work 
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Day 2: Generating Contrast (Tuesday 12th) 
 
 
4     Ian Dobbie   Contrast enhancement (phase and DIC) 
 

• Reiteration of how images are formed – stressing conjugate planes 

• The limits of bright field 

• Dark field microscopy 

• Phase Contrast microscopy 

• Differential Interference Contrast microscopy 
 
 
5 Carina Monico / Ian Understanding and applying fluorescence microscopy 
 

• Why Fluorescence? Contrast 
• What is fluorescence? very simplified Jablonski diagram  
• Basic principle and components of a fluorescence microscope 

• Fluorescent light sources 
• PSF,  OTF and aberrations 
• Fixation for light microscopy 

 
 
6 Mark Howarth  Fluorescent dyes and proteins 
 

• Energy levels in fluorescence; Jablonski diagram 

• Key characteristics of a fluorophore: Stokes shift, quantum yield, photostability 

• Organic and inorganic fluorophores 

• Antibody targeting and how to label protein with dye; direct / indirect labelling 

• Site-specific protein labeling methods (SNAP-tag etc.) 

• Labeling different organelles 

• Different fluorescent proteins- advantages and concerns 
 
 
7 David  Pinto Basic image processing & Image and data management 
 

• What is in an image? 
• Metadata 
• Image Display 

• ImageJ 
• Analysis before image acquisition  
• Noise 
• Images for figures 
• Data storage and backup 
• File formats 
• OMERO & OMERO.figure 
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Day 3: Imaging Approaches for Molecules & Cells (Wed 13th) 
 
 
8 Alan  Increasing contrast and resolution using optical sectioning 

 

• History 

• Point scanning (galvo mirrors) 

• PMT detectors (Including GaAsP detectors) 

• Setting offset and gain 

• Bleed through and sequential scanning 

• Spectral unmixing 

• Spinning Disc Microscopes 

• Multi-photon Microscopes 

• Comparison of Scanning Confocal vs. Spinning Disc vs. Wide field 
 
9   Nadia Halidi  Live-cell imaging 
  

• Why live? Comparison of live cell imaging and fixed cell studies 

• Requirements of live imaging: experimental design and choice of equipment 

• Optimisation: dyes and stains; filter sets; adaptive optics 

• Choice of imaging techniques and sample preparation 

• Image processing and analysis 
 
 
10    Chris L. Imaging at the molecular level: F-techniques 
 

• Fluorescence techniques for molecular dynamics; FRAP, FLIP, FLAP, FCS 
• Techniques to measure molecular interactions such as FRET and FCCS 

 
 
11/12 David  Pinto Advanced image analysis Parts 1 & 2 

• Images as N-dimensional signals 

• Tools for image analysis 

• Interpolation 

• Image filters 

• Image segmentation 
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DAY 4: Beyond Conventional Imaging (Thursday 14th) 
 
 
13  Matthew Stower Imaging biology in context in organs and tissues 
 

• Problems of imaging deep 
• Approaches  
• Using light-sheet imaging to study development 

 
 
14 Lothar   Super-resolution and SIM 
 

• Principles of structured illumination microscopy (SIM) 
• Linear SIM methods  
• Biological application of 3D-SIM: nuclear organisation, live cell imaging 

 
 
15 Jarno Makela   Nanometer resolution by localisation microscopy 
 

• The principle of localisation microscopy; imaging individual molecules 

• Variants of LM: PALM, FPALM, STORM, dSTORM, GSDIM 

• Applications of localisation microscopy; pros and cons 
 
 
16 Silvia/Chris STimulated Emission Depletion microscopy – true  
     optical super resolution 
 

• STED, RESOLFT, STORM/PALM (Differences, Commonalities).  

• An example of STED-FCS (membrane organization of lipids/proteins) 
 

 
17    Ian  Bespoke microscope design 

• Custom microscope design (includes subsequently commercialized examples) 
 

 

  *** CONCLUSIONS & BEER AND PIZZA *** 
 
 
 
 
 
 

_____________________________________________ 

 
Previous years’ lectures can be found here: 

_____________________________________________ 
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DAY 5: Optional Sessions (Friday 15th) 
 

 
 
 
Optional Micron Equipment Demo 

** signup sheets will be available during the course ** 
attend either the morning or afternoon session 

 
The demonstrations will cover: 

• The different instrumentation available in the Micron Advanced Imaging Unit 

• Live demonstrations of equipment performance 

• Discussion of what different instrumentation offers, advantages and disadvantages 

• The possibility to ask about specific applications 
 

 
 
 

OR 
 

 
 
Optional EM Day 

** Limited places, signup sheets will be available during the course ** 

 
 
The lecture will cover: 

• Basic principles of electron microscopy and applications to biological research 
• Biological specimen preparation for EM 
• Advanced EM techniques: cryo-EM, EDS x-ray microanalysis, correlative light & EM, 

3D-EM 
 
The demonstrations will cover: 

• Cryo-EM: Screening protein samples by negative staining, plunge freezing, clipping cryo-
EM grids, screening and data collection on the Talos Arctica cryo-TEM. 

• Cell & Tissue EM: Biological EM sample preparation (including conventional chemical 
prep, microwave prep and cryo-fixation, ultramicrotomy, TEM (including image 
interpretation and spotting artifacts), SEM (including EDS, 3View) 

 
 

_____________________________________________ 
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Self-taught practical exercises 
 
These are a series of optional, self-taught practical exercises that you can run on your 
own (using your own samples and microscopes in your lab) and/or book time on the 
Micron instruments. We can arrange for guidance if necessary and some materials 
may be provided (contact micron@bioch.ox.ac.uk) 

 
 
Practical 1: Basic Microscopy 
Practical 2: Fluorescence Microscopy 
Practical 3: Basic Image Handling in FIJI 
 

___________________________________________ 

 
 

 
 
 
 
 
 
See also the online Practical exercises at: 
 
http://www.micron.ox.ac.uk/microngroup/resources/Brightfield_worksheet.pdf 
http://www.micron.ox.ac.uk/microngroup/resources/Fluorescence_worksheet.pdf 
http://www.micron.ox.ac.uk/microngroup/resources/Bead_slide_prep.pdf 

 

  

http://www.micron.ox.ac.uk/microngroup/resources/Brightfield_worksheet.pdf
http://www.micron.ox.ac.uk/microngroup/resources/Fluorescence_worksheet.pdf
http://www.micron.ox.ac.uk/microngroup/resources/Bead_slide_prep.pdf
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Practical 1: Basic Microscopy 
 
Setting up bright field illumination and optimising contrast 
 
Richard M Parton/Chris Hawes, 2017 
 

Overview 
In this practical, the first aim is to familiarise yourself with the basic parts of a microscope and 
how they are setup. Specifically, the exercises will take you through the correct alignment and 
use of different components in the bright field light path to ensure even illumination: Koehler 
illumination. The second aim is to explore techniques to optimise contrast in bright field, how 
these are setup and their effects on the view down the microscope. An additional aim of 
practical is to look at the issues and constraints of sample preparation for observation down 
the microscope. There will be some consideration of how to care for the microscope during 
use and how to clean objective lenses correctly. 

Specific goals 
 
Part 1 - Basic parts of the microscope (bright-field path) 

• Familiarise yourself with the basic parts of the microscope. 

 
Part 2 - Setting Koehler illumination and adjusting the condenser 

• Be aware of correct alignment and use of different components in the bright field light 

path to ensure even illumination: Koehler illumination. 

 
Part 3 - Contrast generation in bright field using simple samples 

• Be aware of correct alignment and use of different components in the bright field light 

path and how they are adjusted to increase contrast. 

• For the biological material, consider steps you could take to improve sample viability 

and image quality. 

 
Optional Exercise – How to clean lenses 

• Learn how to clean objective lenses safely. 

Learning outcomes 
 
After completing this practical you should: 
 

• Recognise the important components of a simple light microscope and how to set them 
to optimise your view. 

• Be aware of techniques commonly used to generate contrast in biological samples. 

• Be aware of the issues and limitations of preparing and mounting a biological sample 
to optimise observation down the microscope 
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Background  
 
Microscopy has become an indispensable tool in the study of all aspects of cell development 
and biology. Microscopy is relatively non-invasive and quantitative. It can be used to follow 
the behaviour of cells in tissues, the distribution of specific organelles or even molecules inside 
cells and changes in their distribution and interactions over time. Using modern imaging 
techniques, in combination with biochemical and molecular approaches, it is now possible to 
very effectively investigate fundamental questions about the cellular and molecular 
mechanisms underpinning biology.  
 
In order to use a microscope effectively it is essential to have at least a basic understanding 
of what your microscope does, its component parts and how to set them correctly. To achieve 
this, it is also important to fully appreciate the concepts of magnification, resolution and 
contrast in image data and how they are related. 
 
Here we will first familiarise ourselves with the parts of a microscope and then use tissue 
culture cells to help us explore contrast in a biological specimen. 
 
 
 

 
DIC of a cultured plant cell showing cellular organisation including dynamic transvacuolar cytoplasmic strands 
transporting various organoids, DOI: 10.1042/BST0380823 
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Part 1: Basic parts of the microscope 
This practical is intended for a standard wide field microscope with a bright field 
condenser and, ideally, with different contrast enhancing components. Familiarise 
yourself with the parts of a basic compound microscope using the diagram below as a guide. 
Before you can set up a microscope correctly you need to find the components that need to 
be adjusted. 

 
Figure 1 – Simple compound microscope (bright field path) 

 

Experimental exercise – finding your way round the microscope 
 

Find the following components on your microscope (Figure 1): 
 
The stage and specimen holder – There are two main forms of microscope: Upright and Inverted. 
With an Upright you look down upon the specimen, with an Invert you look up at the specimen from 
below. In both cases the bright field path is “transmitted”, the illumination light from the lamp is collected 
by the condenser and passes through the specimen (transmission) to the objective lens on the other 
the other side. 
 
The objective lens and eyepiece - The object is viewed by two lenses, known as the objective lens 
and eyepiece. This arrangement gives two stages of magnification (hence “compound” microscope).  
In the first stage the objective lens forms an image of the specimen at the intermediate image plane. In 
the second this image is viewed by the eyepiece (and the eye). Identify the different objective lenses 
on the microscope. 
 
The bright field condenser lens – Located either under (Upright microscope) or above (Inverted 
microscope) the microscope stage. When correctly set up, light from the source is focused onto the 
specimen by the condenser lens, to provide high intensity, even illumination so that the highest powers 
of the microscope can to be used to optimum effect. Identify the condenser and locate the adjustable 
components associated with it and what they do.  
 
The condenser or aperture iris - This limits the angle of the light passing from the illumination source 
through the microscope. The result is reduction in illumination brightness at the specimen and 
increasing contrast at the expense of resolution as resolution is dependent upon the angle of light 
passing through the microscope).  
 
The field iris - This iris restricts the field of illumination at the specimen. This increases contrast in the 
view by reducing scattered light and reduces specimen photo-damage outside the viewed region. 
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Part 2: Setting Koehler Illumination and Adjusting the Condenser 

The primary purpose of Koehler illumination is to ensure even illumination of the specimen 
field plane, without any "image" of the illumination source itself (e.g. a tungsten filament) 
projected onto the specimen. Nowadays we rarely use bright field microscopy alone, but it is 
useful for demonstrating aspects of the microscope. Refer to Figures 1 and 2 for a diagram of 
the optical arrangement of components for Koehler illumination. (We assume here that the 
illumination source is itself centred, as in most modem microscopes this is fixed. Historically 
this was not the case, and more steps were involved in setting up Koehler illumination.) 
Figure 2 Koehler: Illuminating the image plane with a maximally defocused image of the 
lamp: each point from the lamp contributes equally to illuminating the image plane: 

 

http://www.microscopyu.com/articles/formulas/formulasconjugate.html 

In Koehler illumination a conjugate pairing of “specimen” planes and “illumination” 
planes are established. This arrangement allows specific manipulation of the light 
passing through the microscope (and hence what you see) by careful placement of 
irises and other optical elements. In Figure 2 above, you can think of the Field planes 
as the “in focus” or imaging planes and the Illumination Planes, aperture or reciprocal 
planes, as they are known, as the maximally defocused planes. 

Experimental Resources 

 
A lens tissue prep is a very simple way of obtaining a sample to set up your microscope. To 
make this you will need: Lens tissue, Glass Slide, Coverslip, Water. Pinch off a section of lens 
tissue no more than about 1 cm square, place this in the centre of a glass slide and add a 
drop of water. Gently lower a coverslip into place avoiding air bubbles. Mount on the 
microscope stage and image. Alternatively use a sample of tissue culture cells.  
  

http://www.microscopyu.com/articles/formulas/formulasconjugate.html
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Experimental exercise – set up Koehler illumination 

1. With the condenser wheel set to “bright field or BF” (i.e. with no DIC, phase or dark field optics in 
place), and the aperture diaphragm (NOT the field diaphragm) closed to more than 50%, to increase 
contrast, focus the objective on the test sample. 

2. Now close down the field diaphragm, and focus the condenser (NOT the objective) such that the 
field diaphragm iris appears in sharp focus on the same plane as your sample (the specimen plane). 
NOTE: if you are using a MOTIC teaching microscope, the field diaphragm iris has been omitted. 
To facilitate the set-up of Koehler, plastic printed substitutes or a Thorlabs iris can be used, which 
should be placed in the appropriate location in the optical path (see diagrams). 

3. Centre the field diaphragm by adjusting the pair of knobs on either side of the condenser. (Beware 
condensers that have a third “locking” knob nearby.) Note that when you move these, the edges of 
the field diaphragm will move (because it is "upstream" of the condenser lens), whereas the image 
of the specimen does not move (because it is "downstream" of the condenser). Adjust these such 
that the field diaphragm is properly centred. 

4. Open the field diaphragm such that almost the entire field of view can be seen. This is now Koehler 
illumination. By focusing the condenser in this way (that is, adjusting the position of the condenser 
relative to the already focused specimen) you have brought 2 sets of conjugate planes into the 
special relationship in which each set of planes represents the optical transform of the other set (or, 
more simply, when one set is at best focus, the other set is at maximal "defocus"). See Figure 2 on 
the previous page. 

5. Now experiment with opening and closing the APERTURE diaphragm (previously closed below 
50%). Note that as the aperture diaphragm is opened, the contrast decreases, and the spatial 
resolution improves. The increased resolution may actually be hard to see, as the brightness will 
increase quite a lot, therefore you may have to adjust the lamp intensity to see this. Conversely, 
when you close the aperture diaphragm, the contrast increases, while the spatial resolution 
decreases. Also note that whereas you could see the edges of the field diaphragm iris, when you're 
looking at the specimen you don't see the edges of the aperture diaphragm as you open and close 
it. Also, alter the objective focus above and below the plane of focus, to see how the contrast can 
change. Before phase-contrast and DIC were invented, this method was often used to get a higher 
contrast image of transparent objects.  

6. Return to the properly adjusted Koehler illumination. Now remove one of the eyepieces; this will 
allow you to view the back focal plane of the objective, which is conjugate to the condenser aperture 
plane (a Phase telescope or Bertrand lens are often used to better view the back focal plane). 

7. Looking down the telescope or with the eyepiece removed, adjust the aperture diaphragm—open 
and close it and see that the edges of the iris open and close, and they should be in sharp focus. 
Do the same thing with the field diaphragm. Notice that if you change the diameter of the field 
diaphragm while looking with the eyepiece removed, you will not see the edges. Now repeat the 
same adjustments of the aperture diaphragm, but look down with the eyepiece in observe the same 
changes in contrast that you observed before. Hopefully by now you will have seen and appreciated 
the notion of conjugate planes and inverse relationship between the Field planes and the 
Illumination planes.  

The setup for Koehler and the components involved are found across nearly all microscopes 
both upright and inverted and across the different manufacturers. However, the exact 
placement physically in the arrangement of conjugate planes can vary. 

 
  



 16 

Part 3: Contrast generation in bright field using simple samples 
 
Biological specimens inherently have poor contrast. Much of microscopy technique is 
devoted to enhancing contrast by converting differences within the sample, such as 
differences in refractive index, into differences in brightness which can easily be seen. 
 

 
Simple brightfield vs Differential Interference Contrast (DIC) 
 

Experimental Resources 
Onion epidermis is a simple-to-prepare live sample that can be used to demonstrate bright 
field contrast techniques. Healthy preparations should show clear subcellular structures and 
dynamic movements of cytoplasmic streaming and organelle transport. 
 
 
Section of onion peel mounted for imaging: 

Reagents and materials  
 
Large onion 
Lens tissue  
Mounting solution (water) 
Plastic Pasteur pipette 
Glass slides / Coverslips 
Forceps 
Scalpel or safety blades 
Plastic mounting frames  
Plastic dishes (to store samples) 

Humidified chamber 
 
 
 
 
 
 
 

 
http://www.microscopy-uk.org.uk/mag/indexmag.html?http://www.microscopy-uk.org.uk/mag/artoct11/wd-onion9.html 
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Experimental exercise – viewing onion epidermis under different contrast techniques 

 
First prepare onion epidermis: 
 

 
1. Peel away the papery outer layer of the onion then first cut a “boat shaped” section from 

the fleshy layers about 3-4 cm wide using a blade*. When you lever off the section, there 
should be a thin epidermal layer weakly attached to the concave side. * CAUTION: Do not 
attempt to cut the onion while holding it in your palm! Keep fingers away from the blade 
when cutting! 

 
2. This epidermal layer can be conveniently isolated for viewing by sticking it to a “plastic 

frame” with double sided sticky tape on one side. Using the pre-prepared plastic frame 
you will isolate a section of epidermal peel: first, remove the covering from the double-
sided sticky tape (do not touch the sticky surface); next press the sticky side down firmly 
but carefully against the epidermal layer, trim away the excess outside the frame with the 
blade and peel carefully away. You can produce several peels and store them floating on 
drops of medium in a Petri dish. * Note there are two distinct sides to the epidermal peel 
* 

 
3. Mount the isolated peel in a drop of medium on a glass slide and place on the microscope. 

Mounting “frame side up” puts the shiny waterproof side of the peel uppermost. 
 
4. Select a low mag objective (10x or 20x), focus and view the specimen. 
 
5. Remove the sample from the microscope, add an extra drop of water on top and add a 

coverslip on top, don’t add too much water and avoid air bubbles. 
 

6. Change to a 40 lens. Adjust the condenser diaphragm to generate contrast.  
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Next try a Dark field technique to improve contrast: 
 
If the microscope has a dark field position in the condenser it can be inserted in the 
optical path. If the microscope does not, for example the basic MOTIC teaching 
microscopes, you can approximate dark field by using the condenser phase annulus 
for a high-power objective (e.g., Ph3) in combination with a low-power low NA 
objective (e.g. 10X or 20X Ph1). For the Motic teaching microscopes there are 
plastic inserts that approximate dark field. 
 

 

1) With a sample mounted on the microscope (for example a lens tissue sample) and x10 
objective, set up Koehler illumination as previously described. Set the aperture 
diaphragm nearly all the way open. 

2) Rotate the filter holder on your condenser to select the dark field component  [for Motic 
teaching microscopes, insert the 3D printed Dark field plastic insert into the 
appropriate port in the condenser. The insert has two stop positions with the plate 
either in or out of the optical path.] 

3) Slowly close the aperture diaphragm until all the light to the specimen is cut out and 
then open it up slightly.  

4) The lens tissue sample viewed with a x10 objective works very well with the dark field 
inserts. Try moving the insert in and out of the optical path and see the view change 
from grey to a highly contrasted bright image on a dark background. 

5) Remove the Dark field component from the path and set up an onion epidermis sample 
of the microscope. 

6) Try the effects of opening and closing the aperture diaphragm and then set the 
aperture diaphragm nearly all the way open.  

7) Repeat the exercise of inserting the Dark field component into the optical path and 
then slowly closing the aperture diaphragm until all the light to the specimen is cut out 
and then opening it up slightly. What differences are there in what you can see? 

8) Try the same with different objectives. 

 
 
Lens tissue sample under the microscope:  

 
 
              Bright field         Bright field      Dark field 
        (aperture iris open)           (aperture iris closed)     
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Onion epidermis under the microscope:  

 
  Bright field       Dark field 
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Additional Technical Notes: 

Phase contrast microscopy *this assumes that your microscope has both phase 

condenser components and phase objectives (identified by Ph and a number e.g. Ph3). 

The second purpose of Koehler illumination is that phase-contrast and DIC, the two 
major methods generating contrast from "transparent" specimens with transmitted 
light, require that the condenser aperture plane is conjugate to a specific plane in the 
objective—the "back focal plane" (which is what you were looking at with the phase 
telescope/Bertrand lens). 

1. Switch the condenser to a phase setting that matches the objective being used, 
marked on the objective as Ph-1 or similar. Note that usually there is no condenser 
aperture diaphragm to open or close, as the aperture diameter is now fixed by the 
fixed-size phase-annulus inside the condenser - otherwise select the appropriate 
aperture setting - too far closed and everything will be dark. If possible, take the 
condenser off of the microscope and study the different possibilities that can exist 
in the aperture plane. 

2. Assuming the phase contrast is already well-adjusted - look down the eyepieces at 
the sample slide. (Setting up good phase requires that the phase ring in the 
objective and in the condenser are correctly aligned.) Now you will see a great deal 
of contrast, against a hopefully uniform grey background. Note that the cell is likely 
to produce both areas that are darker than the background and also areas that are 
lighter than the background, especially the so-called "phase halo" around 
particularly thick or refractile objects, such as yeast. The reasons for the phase halo 
are quite complex, but it is useful to know that DIC does not generate such a strong 
halo (but is much more expensive). 

3. For a technical explanation of phase-contrast see Fig 2 (below). To appreciate it 
more, take out one eyepiece and insert the phase telescope to look at the back 
focal plane of the objective. You should see two rings—a bright ring inside a 
somewhat larger dark ring. The bright ring represents the hollow cone light 
produced by the phase annulus in the condenser. It is matched in size with the 
darker phase ring in the objective. Remember the dark phase ring in the objective 
does two things: (1) it introduces a phase shift of 90° (one-quarter wavelength) to 
the light that passes through it (which is nearly all zero-order, non-diffracted light); 
(2) it is also darkened, to reduce the intensity of the zero-order light which passes 
through it. This means that only a relatively small amount of incoming light is 
actually diffracted by the specimen. Therefore, if the interference between non-
diffracted light and the light diffracted by the specimen ("higher-order" light) is to be 
visualised, it is important to reduce the total intensity of the non-diffracted light. This 
is also why the background in phase contrast appears to be grey, even though you 
may be putting a lot of light onto the specimen. You will notice if you switch back to 
the brightfield position on the condenser, that in phase-contrast, most of the 
incident illuminating light does not contribute to the final image. 

4. Now, looking at the back focal plane of the objective, switch to the condenser bright-
field position. The bright ring of light should now be replaced by a broader circle of 
light. Switch back to the phase-contrast position on the condenser. 



 21 

5. Now see how different adjustments to the system affect the quality of the phase-
contrast. First, with the edges of the field diaphragm in view, reposition the 
condenser using its positioning knobs, and see the effect of this, both at the back 
focal plane and on the image. Then adjust the position of the phase annulus within 
a properly adjusted condenser. (On older microscopes, this is easily accessed by 
the user and therefore often put out of adjustment - on most modem microscopes 
it is more difficult to misalign). Again observe the differences both on the back focal 
plane through the phase telescope and on the image plane, through the eyepiece. 
You should see that as the bright ring no longer superimposes on the dark ring, the 
quality of the phase contrast is significantly altered. 

 
Figure: Optical Arrangement in Phase Microscopy 
 
In Phase microscopy the specimen is illuminated through a ring aperture or condenser 
annulus (placed in the condenser conjugate plane, out of focus with the specimen plane). This 
produces a cone of light with most being blocked. When this passes through the specimen 
plane some light is unaffected and gives the background while some is scattered and gives 
rise to foreground details. Generally the scattered light is weak and -90° phase shifted relative 
to the background light so there is little difference intensity between the foreground and 
background so there is poor contrast. However, by placing a Phase plate (See figure below) 
in the back aperture of the objective (at the corresponding conjugate plane to the condenser 
annulus) the background light is phase shifted by -90°, effectively eliminating the phase 
difference relative to the scatted light which interacted with the specimen. The result at the 
image plane is that the diffracted foreground and non-diffracted background light have 
increased intensity differences providing greater contrast. 
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PHASE MICROSCOPY: 
 
(Lecture notes Ian Dobbie /  http://en.wikipedia.org/wiki/Phase_contrast_microscopy) 
 

• Invented by Zernike, a physicist, in the 1930s (Nobel Prize, 1953) 

• Uses interference of light waves to turn “invisible” phase differences (induced by the 
specimen) into contrast (differences in intensity) in the image 

• Works by separating the illuminating “background” light from the “foreground” light that 
interacts with the specimen (for example the nucleus and small plastids) and treating 
them differently. 

 
 

Constructive and Destructive interference and the Phase of light rays 
 
Image formation in the microscope is the result of the refraction and interference of light rays. 
Light rays that are “in phase” interfere constructively resulting in increased amplitude 
(brightness) while “out of phase rays” interfere destructively resulting in reduced amplitude. 
Phase shifting can be caused by material in the optical path for example organelles and 
cytoplasm of different viscosities. 
Phase (according to the Oxford Dictionary) may be described as “the relationship in time 
between the successive states or cycles of an oscillating or repeating system (such as a light 
wave) and either a fixed reference point or the states or cycles of another system with which 
it may or may not be in synchrony”. 
 
Constructive and Destructive interference 

 
  

http://en.wikipedia.org/wiki/Phase_contrast_microscopy
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DIC microscopy (also known as Normarski) The requirements for DIC are: 
polarizer, analyzer (the pair of polarising filters before and after the objective, 
respectively), Wollaston (in the condenser) and Wollaston (at the back of the 
objective). DIC is the most complicated of all transmitted light methods and requires 
the most expensive components. Although the principles of DIC are nearly the same 
on all microscopes, different manufacturers engineer the components differently. 
Therefore, we will just observe the effects of bias retardation, etc. If possible, take out 
both Wollaston prisms (rotate the turret of the condenser to bright field and remove 
the prism at the objective) so that you have only the polariser and analyser present. 
For good DIC, the two polarisers should be “crossed” i.e. rotated 90° to each other so 
they transmit very little light. 

If you have a de Sénarmont-type DIC (rotatable polarizer), rotate this and observe the 
effects on the brightness of the image. Otherwise, or in addition, slide the analyser in 
and out of position to observe the effects on the brightness of the image. 

1. Now rotate the condenser to the appropriate DIC position to introduce the 
condenser Wollaston (the condenser Wollaston should be matched to the objective 
used), and put in the objective Wollaston (this may be specific for the objective used 
or a single Wollaston for all objectives). Observe the changes in the image. 

2. Change the bias retardation ("shadow") by adjusting either the objective 
Wollaston (e.g. Zeiss) or the angle of the polarizer if you have de Sénarmont-type 
DIC (e.g. Nikon). Notice that as the bias changes from positive to negative (i.e., on 
either side of zero, you change the direction of the apparent shadow). You should 
aim for an even grey background with the features of interest well contrasted in the 
specimen. 

Onion epidermis prep viewed under DIC: 
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Practical 2: Fluorescence 

 
Updated, Richard M Parton 2019 

Overview 
 
Fluorescence has become one of the most important contrast techniques in modern biology 
and is supported by extensive development of both microscope hardware and dyes. As a 
testament to its success, a huge diversity of technical approaches, based upon fluorescence 
microscopy have been developed to tackle a diverse range of experimental questions. 
 This practical first examines the wide field fluorescence microscope – either upright or 
inverted. Different microscopes will look very different, however, all wide field fluorescence 
microscopes are basically the same and share the same major components. More advanced 
imaging systems such as Confocal, Multiphoton or TIRF systems are based upon a basic wide 
field fluorescence stand and will generally incorporate a wide field fluorescence excitation light 
path for direct viewing. The second part of the practical deals with the issues of fluorescently 
labelling and imaging a biological specimen. 

Specific goals 
 
Part1 Familiarising yourself with the fluorescence path 

• Acquaint yourself with components of the fluorescence path and their setup. 

 
(More experienced microscopists may want to spend most of the time on Part 2 of this exercise 
as long as they have gone through the first part to confirm that they know it well, see 
http://en.wikipedia.org/wiki/Fluorescence_microscope for an explanation of fluorescence 
microscopy). 

 
Part2 Fluorescence labelling 

• To use selective fluorescent stains to increase contrast in a biological specimen. 

• To observe the affects a labelling procedure can have upon a biological specimen. 

• To observe how the labelling procedure can affect what you see. 

• To observe bleaching. 

• Optional – to observe Airy rings and the Point Spread Function 

Learning outcomes 
 
Through this practical you will learn: 

• How and why the fluorescence path is set up the way it is. 

• To recognise and adjust the components of the optical path. 

• To appreciate the issues associated with labelling and imaging biological samples. 

  

http://en.wikipedia.org/wiki/Fluorescence_microscope


 25 

Background 

Most modern fluorescence microscopes are based upon an epi-fluorescence configuration. In 
this setup only the emission light that returns through the objective is imaged. This is in contrast 
to transmitted light, for example bright field, which passes through and is collected on the other 
side of the specimen by the condenser.  In epi-fluorescence the objective itself also acts as the 
condenser. Koehler illumination is important for the same reasons as bright field: to ensure even 
and intense illumination of the specimen without an image of the mercury light source. However, 
in most fluorescence microscopes no alignment is required to achieve Koehler illumination. You 
simply focus on the specimen.  

 

 

 

The field diaphragm is used to reduce out of focus light on the region of interest (pseudo-
confocal effect) and stop bleaching outside the region observed. The field aperture has 
centering screws, but normally should not need adjusting. 

Aperture diaphragm (not always present) is usually left in the fully open position.  

Neutral density filters can be used to reduce the intensity of illumination.  

A heat (IR) filter is usually present to avoid damage to living cells (interference filters do not 
necessarily block IR). Optical elements in light path are usually UV-transmitting to allow 
excitation in near UV. UV filter can be introduced.   

Stop slider blocks all fluorescent illumination when not looking at specimen to avoid damage 
to filters (see below). Do not have the DIC analyser and other components in place when 
using fluorescence: reduces intensity hugely and damages polarising filters (exceptions to this 
rule are when signal is very strong and you require simultaneous DIC and fluorescence imaging, 
although better alternatives exist). 
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Example of a fluorescent teaching scope (upright): 
 
 
 

 

Part 1: The fluorescence path 
 

Experimental Resources 
 
Fluorescent fixed material test slides may be 
purchased from Thermofisher, a simple lens-tissue 
preparation (opposite) is also fluorescent: excited in 
the blue 488 nm with emission in the green (520 nm) 
using a FITC or GFP filter set. 
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Experimental exercise: The fluorescence path 
 
 

Identify the following parts of your fluorescence microscope (You may 
want to refer to the anatomy of an upright research microscope, see figure 
over the page): 
 
The excitation light source (fluorescence lamp or equivalent) - Fluorescence 
microscopy uses bright short wavelength excitation light to elicit weak longer 
wavelength emission from the specimen. 
 
The condenser lens (fluorescence path)- When correctly set up, light from the 
source is focused onto the specimen by the condenser lens, to provide high 
intensity, even illumination so that the highest powers of the microscope can be 
used to optimum effect – this is known as Koehler illumination. Note: in epi-
fluorescence the objective lens acts as the condenser lens so the two are 
perfectly matched.  
 
The condenser or aperture iris (fluorescence path - may not be present on all 
fluorescence microscope stands) - This limits the angle of the light passing from 
the illumination source through the microscope. The result is reduction in 
illumination brightness at the specimen and increasing contrast at the expense 
of resolution due to the fact that resolution is dependent upon the angle of light 
passing through the microscope).  
 
The field iris (fluorescence path) - This iris restricts the field of illumination at 
the specimen plane. This increases contrast in the view and reduces photo-
damage outside the viewed region of the specimen. 
 
The dichroic mirror (fluorescence path) – Fluorescence microscopy uses 
bright short wavelength excitation light to elicit weak longer wavelength 
emission from the specimen. In a transmitted configuration (like bright field) the 
transmitted excitation light would swamp the emission signal giving poor 
contrast, even with wavelength discriminating filters. Epi-fluorescence relies on 
a dichroic mirror that interacts differently with light of different wavelengths. In 
a simple dichroic, light below a certain wavelength is reflected and above that 
wavelength transmitted. So – short wavelength excitation is reflected onto the 
specimen while longer wavelength fluorescence emitted towards the dichroic is 
transmitted to the detector. Short wavelength excitation light scattered towards 
the dichroic is reflected away from the detector. 
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Components of an Inverted Fluorescence Olympus Microscope 
 

 
 

http://www.olympusmicro.com/primer/  http://www.microscopyu.com 

  

http://www.olympusmicro.com/primer/anatomy/anatomyjava.html
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Part 2: Fluorescence labelling 
 

Experimental Resources 
 
Good test materials include onion epidermis (See protocol in Part 1) or commercial pre-
prepared fluorescently labelled slides for example the  “FluoCells™” slides from 
Thermofisher: 
https://www.thermofisher.com/order/catalog/product/F36924?SID=srch-srp-F36924 

Pre-prepared slides are available labelled with a range of fluorescent probes for organelles 
e.g. bovine pulmonary artery endothelial cells double labelled with DAPI-mitotracker-phalloidin 
or DAPI-phalloidin-anti-tubulin. Refer to the slide for information of imaging conditions, DAPI 
is generally excited at 405 nm and emission is collected ~480 nm. 

 

 
A good source of dyes is Molecular Probes (Thermofisher): 
http://www.lifetechnologies.com/uk/en/home/brands/molecular-probes.html?icid=fr-
probe-main). 
 

 
Bead slides for assessing imaging system performance and point spread function 
measurement are readily available commercially, however extensive ranges of fluorescent 
beads are available and preparing a bead slide of your own is trivial (see later protocol). 
 
 
 

Fluorescent dyes can be pre-prepared as stock solutions: 
 
Calcofluor white (Optical brightner) – cellulose selective stain. Absorbs in the UV/farUV, 
emits blue (410 nm). 0.1mg/ml in water. Add one drop to drop of suspension culture cells on 
microscope slide. 
 
DiOC6– ER/mitochondria selective stain.  Use at 1-5 µg/ml. Peak excitation 484nm (blue), 
emission 518 nm (green). 
 
Hoechst 33342 (cheap version of DAPI). – Nucleic acid selective, nuclear (chromosome) 
marker. Stock solution 1mg/ml in DW. Use at 1 µg/ml in 1% paraformaldehyde, plus 1% Triton 
100 to permeabilise plasma membranes. 
 
 

 
  

https://www.thermofisher.com/order/catalog/product/F36924?SID=srch-srp-F36924
http://www.lifetechnologies.com/uk/en/home/brands/molecular-probes.html?icid=fr-probe-main%20http://www.lifetechnologies.com/uk/en/home/brands/molecular-probes.html?icid=fr-probe-main
http://www.lifetechnologies.com/uk/en/home/brands/molecular-probes.html?icid=fr-probe-main%20http://www.lifetechnologies.com/uk/en/home/brands/molecular-probes.html?icid=fr-probe-main
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Optional Exercise 

Observing Airy rings and the point spread function (PSF) (Bead slide) 

 
Observe airy rings: 
Bead slides can be large (to 5 um) multi labelled beads or single dye labelled 
subresolution beads (170 um). The coverslip should be No. 1.5 (0.17mm) thicknessp. 
A lens tissue fragment included in a bead slide prep can assist in finding the correct 
plane of focus. Bead slides and bead suspensions are usually available in Micron upon 
request. 
 
Observe spherical aberration: 

Examination of the PSF can reveal a variety of aberrations of the system from 
misalignment, air bubbles in the immersion media, slides which are mounted at an angle 
and spherical aberration due to refractive index mismatch along the optical path. The 
latter is one of the most common causes of poor image quality. You can try to identify 
spherical aberration in the bead slides. You can also examine ways of correcting 
spherical aberration using objectives with collar corrections, different refractive index 
oils or lens that use different immersion media. 

 

By focusing up and down on a field of beads with different objectives try to observe 
some of the following: 

1) Airy rings of out of focus light above and below the beads. Do the Airy rings differ 
between the beads on the coverslip and those on the slide? 

 

2) Different pattern of airy rings in the centre of the field of view and at the edges. 
Compare plan lenses with non-plan lenses.  

3) Note that the shape of the Airy rings will vary considerably with the type of objective 
and make of the microscope.  
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4) You can assess how well your system is performing by comparing your PSF to the 
theoretically determined resolution limits of the system. In practical 3 raspberry Pi’s 
will be used to drive automated focus and image capture to collect Z-stacks – 
series of images at different focus depths – and view them in ImageJ. These 
setups will be used to collect PSF data sets 

 

 
  

Bead sample preparation: 
 
We prefer beads such as the Nile Red 210 nm beads that can be viewed with either 
FITC (GFP) or TRITC (Rhodamine; RFP) filter sets. To assist in focusing on the 
beads you can add a small fragment of lens tissue to the drop of mounting medium 
on the glass slide before covering with the bead-coated coverslip. 
 
1. Dilute fluorescent beads 1:106-107 in ddH2O. To properly assess PSFs, beads 
should be dilute enough that a single bead can be found without Airy discs 
from neighboring beads encroaching as you focus up and down.  
 
2. Apply 10-20 µl of bead suspension to a clean coverslip (usually No. 1; 22x22), 
spread with a pipette tip, and allow to air dry. 

3. Apply 10-20 µl of 90% glycerol solution to a pre-cleaned microscope slide 
then mount the previously prepared coverslip by gently lowering it onto the 
glycerol drop to avoid air pockets. 

4.  While most calibrations will be performed using beads on the coverslip, if 
you want to image structures at >10µm depth into the sample, calibrations may 
be performed on beads several µm away from the coverslip. In this case, PSF 
beads may also be deposited on the slide itself, in parallel with depositing 
them on the coverslip. The distance between slide and coverslip may be 
adjusted by varying the amount of glycerol used to mount the coverslip.  

5.  Calibration slides may be produced for various mounting media: e.g. using 
Prolong Gold, Vectashield, water or Agar instead of glycerol. 

6. Seal the coverslip with clear nail-varnish, wait for it to dry and repeat. Store 
slides flat at 4 degrees. 
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Practical 3: Basic Image Handling in FIJI 
 
Maryam Qurashi & Richard M Parton, 2017 

Overview 
 In this practical you will be introduced to FIJI (ImageJ), a software project 
initiated at the National Institute of Health, Maryland USA (http://imagej.net/Welcome 
& http://fiji.sc). This is the most widely used, open-source microscopy image analysis 
program in use today. It is a java-based free software with an extremely active 
development community. FIJI is a distribution of ImageJ with numerous additional 
plug-ins and useful modalities. You will learn how to install, configure, and cite 
FIJI/ImageJ. You will learn how to open a wide variety of image formats into ImageJ 
and how to rearrange stacks of data to make sense of a multidimensional imaging 
project. You will cover some basic image processing tools and learn how to interpret 
the imaging histogram and understand its crucial role in the visual presentation of your 
data. 

Specific goals 
• Install and configure ImageJ/FIJI 

 

• Import and manipulate multidimensional raw data 

• Explore the Bioformats plugin to open unusual files 

• Use the ImageJ ‘stack’ and ‘hyperstack’ and see how the metadata is read 
to interpret multidimensional data into ImageJ 

• Rearrange stacks and hyperstacks 
 

• Basic image processing 

• Working with the image histogram 

• See how brightness/contrast are adjusted using the image histogram 

• Explore the impact of 8-bit conversion 

• Simple segmentation using thresholding to generate a binary image 

Learning outcomes 
 
After completing this practical, you should: 

1. Be able to install, configure, and cite ImageJ/Fiji 
2. Be able to open raw, multidimensional data from all general image formats 

and many raw microscopy formats 
3. Be able to rearrange your multidimensional data and understand the impact of 

metadata 
4. Be aware of the concept of image authenticity 
5. Know how to use the image histogram to optimise the visual utility of your 

image 
6. Be able to perform simple segmentation 

  

http://imagej.net/Welcome
http://fiji.sc/
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Experimental Resources 
 
For this practical you will mostly use the standard Image J sample data, available 
with Fiji (File / Open Samples / …). 
 

 
 
 
In addition, there will be two additional datasets made available on Weblearn: 

1) Mitotracker_Tom20_MitochondrialNetwork_FIJISAMPLE-MJ.tif – with 
mislabeled metadata 

2) THRESHOLDING_PRACTICE_FIJISAMPLE-GY.tif – for thresholding practice 
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Experimental exercise 1: Fiji is just ImageJ 
 
1. Download FIJI from https://fiji.sc/  Fiji is supported on the following systems: 

• Windows XP, Vista, 7, 8 and 10 

• Mac OS X 10.8 "Mountain Lion" or later 

• Linux on amd64 and x86 architectures 

 However, Fiji (like ImageJ) should run on any system for which a Java 8 

 runtime is available  (Solaris, Raspbian, etc.). 

2. Follow normal installation instructions. 

Copy ImageJ/FIJI download files onto your C:\ (Windows OS) or into your 

Applications folder (Mac OS) 

*Windows OS: Store ImageJ.app somewhere in ‘C:\Users\YOURNAME’. Do not 

attempt to store in ‘C:\Program Files’ as this will prevent ImageJ write permissions 

and it will not be able to update 

3. Open ImageJ/FIJI 

4. Alter Memory Use: 

Edit → Options → Memory will enable you to change the default memory allocation. 

Depending on whether you are running Windows 32-bit or Windows 64-bit, you will 

have an optimal maximum memory allocation for FIJI. It is recommended that 32-bit 

users should not extend their maximum memory allocation to beyond 1.5-1.7 GB 

(Windows 32-bit takes up 2 of the 4 GB address space on 32-bit processors). 

Exceeding 75% of that memory will result in overloading the swap space on your 

drive, delaying or preventing further FIJI operations from being possible. 

 

https://fiji.sc/
file:///C:/C:/
file:///C:/C:/Program
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Experimental exercise 2: Import your data correctly 
 
1. Open a default ImageJ sample: 

File –> Open Samples → Embryos.jpg and resave as a .tif. This is the optimal image 

format for saving image data. Z-stacks, time-series, are all optimised for tif format. 
Google why this might be the case and make a compelling argument for tif files. 

 

2. Open 3D data : 
 
File → Open Samples → mri-stack.tif.  Use the slider to explore the scan. 

 Open all images : Image → Stacks → Stack to Images 

 
3. Reslice/Resample/Rearrange Slices : 

 
Image → Stacks → Tools → Stack Splitter/ Stack Sorter 

 
4. Open multidimensional data: 

 
File → Open Samples → mitosis.tif.  This opens the 5D viewer. Correctly identify 

the five dimensions and give the number of images associated with each dimension. 

  
5. These can be separated step-by-step: 
  

Channels : Image → Colour → Split Channels/Channels  Tool/Arrange Channel 

*Note the  arbitrary colour assignment to the channels by number. ‘Channels 
Tool’ allows you to reassign the colours 

 
Time Points : Image –> Hyperstacks → Reduce Dimensionality  

 
4. Using the Bio-Formats Importer: 

 
Plugins → Bio-Formats → Bio-Formats Importer. Having read the options for 

Stacks in the Bio-Formats Interface, select a reasonable option and open a 
mislabeled .dv file. Rearrange this file to open correctly. 

 
5. Virtual Stacks: Reopen mitosis.tif as a virtual stack. 
 

Virtual stacks are stored on the disk as opposed to your RAM. This has advantages 
for processing speed, however they are read-only as a default. Open Virtual Stacks by 
the Virtual Stack Opener: 

 
File –> Import –> Image Sequence → Virtual Stack Opener 

 
Numerous other dialogs now have the option to open Virtual Stacks. 
File –> Import  → Raw 
File –> Import → Stack from List- 
File –> Import → AVI 

 
Due to their read-only status, Virtual Stacks do not save pixel data, therefore changes made 
to one slice are not maintained on separate slices (e.g. Thresholding/ Creation of a Selection 
box etc.). This can be dealt with by the creation of a macro that processes the slices in turn 
using a ‘Batch’ process, a loop that addresses each slice individually. 
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Process Virtual Stack: Process → Batch → Virtual Stack to work around this read-

only status 
 
**Using this batch processing is beyond the scope of this tutorial but it is important to be aware 
that you can open Virtual Stacks when viewing extremely large stacks or stacks of large files. 
You will not need to compress the image and lose information by this method. Beware that 
you can still run out of memory by applying too many commands to a Batch process working 
on a Virtual Stack. Please come see me in the Micron office if you’d like specific help working 
with Virtual Stacks. 
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Experimental exercise 3: Basic Segmentation 
 
1. File –> Open Samples → bridge.gif and save as a .tif 

2. Open the Image Histogram and try to interpret it: 

Analyse → Histogram: Select the ‘Live’ option and sample different parts 

of the image. 

Image → Adjust → Brightness/Contrast: Using this option, explain how the 

line’s intersection with the histogram alters the assignment of grayscale in 

the image. 

 

3. Open the t1-head.tif  sample and save as a .tif. 

Open the image histogram and select ‘Live’. Convert from 16-bit to 8-bit 

(Image → Type → 8-bit) and create another image histogram. Explain the 

change in the histogram’s shape. 

 

4. Open THRESHOLDING_PRACTICE_FIJISAMPLE-GY.tif 
 

Using Image → Adjust → Threshold, experiment with different 

thresholding algorithms that can help to identify individual eggs. Describe in 
detail what a binary image is and how thresholding can create one. 
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Experimental exercise 4: Batch Processing and Macros 
 
1. Plugins → Macros → Record: This opens the macro recorder. Any actions 

performed in the GUI are recorded in the ImageJ Macro Language (IJM). This allows 

you to interpret your pipeline in a format compatible with creating macros or setting 

up batch processing. 

 

 

 

 

 

2. Process → Batch → Macro: With the recorder open, repeat steps 1-4. Create a 

batch process from your recorded macro. Pay close attention to the input of the 

macro, how might this be adapted for images with regular filenames? 
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Useful contacts and information 
 

Micron Advanced Bioimaging Unit 
http://www.micron.ox.ac.uk 

 

 
Ian Dobbie, Acting Facility Manager 

ian.dobbie@bioch.ox.ac.uk 
 

Carina Monico, Assistant Facility Manager 
carina.monico@bioch.ox.ac.uk 

 
Nadia Halidi, Assistant Facility Manager 

Nadia.halidi@bioch.ox.ac.uk 
 

Richard Parton, Senior Imaging Specialist 
Richard.parton@bioch.ox.ac.uk 

 
General enquiries 

Micron@bioch.ox.ac.uk 

 
 

Lecture Material 
 

http://www.micron.ox.ac.uk/microngroup/ONBI_Course.php 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

  

http://www.micron.ox.ac.uk/
http://www.micron.ox.ac.uk/microngroup/ONBI_Course.php
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